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1. BACKGROUND AND STATEMENT OF PROBLEM 

The use of visual simulation tools to convey complex concepts has become a useful tool in 

education as well as in research. This is most evident in the sciences and engineering where the 

animated expression of concepts allows students to more easily visualize and understand 

complex and interrelated events and processes. Too often, however, visual simulation tools have 

been designed without the pedagogical foundation of sound curriculum design practices. This 

report describes a project that developed curriculum and visualization tools to train transportation 

engineering students to more deeply understand complex traffic control systems and to have an 

increased ability to prepare designs to improve these systems. These goals were accomplished by 

using visual simulations of traffic scenarios that are integrated with pedagogically sound 

curriculum. This first chapter describes the pedagogical background for this work, the previous 

work in this area completed at the University of Idaho (UI), the VISSIM simulation environment 

and its current capabilities, and a summary of the work completed as part of this project. 

Pedagogical Background 

Generally, the approach taken by most universities and engineering programs to learning and 

teaching is not learner centered and does not address the complex problems faced by engineers in 

practice. Previous educational beliefs supported the notion that providing students with 

information was all that was required for successful learning. However, educators cannot expect 

students to learn how to problem solve solely through demonstrating and assigning homework 

problem sets (McDermott, 1993). Research in the field of physics instruction (Leonard, et.al., 

1999; Mestre, 1994) argues that educators need to understand “the mental processes involved in 

the acquisition of knowledge and in the use of knowledge to solve complex problems” (Mestre, 

1994). To encourage the development of future engineers’ high-level problem solving skills that 

will be required for success in practice, instructors must engage students in rich, inductive, and 

active learning environments. The current state of engineering education places substantial 

emphasis on the coverage of expansive bodies of knowledge rather than placing the emphasis on 

teaching students the thinking skills required to solve complex problems (Wales, Nordi, and 

Stager, 1989). In an endeavor to teach engineering, instructors attempt to cover encyclopedic 

textbooks in a short time period such as a quarter or semester. This approach to education is 

antiquated, assuming that knowledge can simply be transmitted to a receiver. In response to the 



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 3 

large amounts of material students are faced with, they end up “learning nothing about 

everything” and begin to refine their dead-end strategies in an attempt to survive the course 

(Wales, 1989). 

Kyte (2002) notes that existing textbooks include problems that are “narrowly based, have 

simplistic solutions, and only require students to substitute numbers into equations to produce 

single and simplistic ‘correct answers.’” Kyte (2007) further notes that the lack of active learning 

environments is evident across transportation engineering, the narrowly based problems 

presented in textbooks use single-answer problems and do not often apply best practices in 

engineering education. Wales (1989) elaborates on this idea, “The engineering workplace is 

characterized by open ended problem solving, with little given information and a multitude of 

potential solutions. In contrast, students in current engineering courses solve well-defined 

problems only with one correct numerical solution.” It is difficult for students to apply concepts 

that were presented in educational settings to a workplace environment and this may pose a 

problem to employers. Students are not adequately prepared for the workplace when they are 

only required to answer single-answer questions and often times they may feel overwhelmed. 

“Research has shown that in order for engineering students to be innovative and productive 

practicing professionals, their learning environment must simulate the environments in which 

they will practice” (Kyte, Bertini and Brown, 2007 and Kyte and Brown, 2009). The problems 

presented in the workplace require more knowledge and problem solving skills than students are 

required to develop during their university education. Murphy (2002) and Prinz (2004) state that 

“knowledge necessary for engineering design and innovation refers to more than just the ability 

to search for an equation that suits the situation, but the ability to understand, apply, and transfer 

information to new situations.” The success of a student when making the transition to a 

workplace setting is dependent upon their ability to adapt and innovate.  

Research has been conducted on the learning that will allow students to be most successful in 

their future endeavors. Brown, Collins, et.al (1989) state “the context in which a student learns 

has much to do with the kind and quality of learning; there is substantial evidence that the 

learning context be consistent with that utilized in practice.” Providing students the experience of 

learning in a realistic environment one that successfully duplicates the environment in which 

they will practice transportation engineering is essential (Kyte, 2009). Redish and Smith (2008) 
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note that “students learn the practice of science and engineering not only the knowledge needed 

but how to use that knowledge in authentic contexts.” This approach can be referred to as 

student-center learning. Burke, et.al defines this as “a performance-based philosophy of 

education which integrates many different theories, processes, and tools in emphasizing the 

continuous development of learning skills through the use of assessment principles in order to 

produce learner self-development. Felder also notes that “problem-based learning…creates 

opportunities for students to engage in practices similar to those of experts.” Liao, Liu, and 

Levinson (2009) show evidence that the use of simulation allows learners to be actively engaged 

through running experiments, testing different strategies, and building a better understanding of 

the aspects of the real-world the simulator depicts. The current state of engineering education 

does not provide students with a rich, active, learning environment from which they will benefit. 

There must be significant changes made to the approach of engineering education to bring the 

emphasis to student-centered learning environments focused on the cultivation of knowledge and 

understanding of the topics.  

Nicholas (2011) has recently studied the impacts on the use of animation of signalized 

intersection traffic flow and signal system operation on the depth of understanding of 

engineering students of these systems. Her study showed that visual representations aid in 

student learning because the majority of people do not think in words, but rather in visual 

images. The visual representation of a problem can be more effective in illustrating the 

connections that are present within a process. Nicholas also found that animation is a useful tool 

to illustrate a process; it attracts attention and maintains student interest in the learning tasks. 

Animation is also able to show relationships in a process more obviously than standard static 

representations. 

Previous University of Idaho Work 

The University of Idaho has a long history of research and educational work in traffic signal 

control systems. During the past decade, UI has lead four projects in which hardware, software, 

and curriculum have been combined to provide richer learning experiences for transportation 

engineers and students. 
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From 1998 to 2002, a University of Idaho-led team developed and licensed the Controller 

Interface Device (CID), a real time communications device connecting a microscopic simulation 

model (such as VISSIM or CORSIM) and a NEMA or 170 traffic controller. This technology is 

often called hardware-in-the-loop simulation (HILS). More than 100 CIDs were sold to the 

Federal Highway Administration and to over thirty university and research organizations 

throughout the United States. The UI maintains a traffic controller laboratory in which more than 

ten CIDs are used for research and educational purposes. The University of Idaho, as well as 

many of these research organizations, has completed a number of research projects and published 

journal articles using HILS technology.  

From 2000 to 2007, UI delivered a week long Traffic Signal Summer Workshop in which over 

80 students from universities from around the United States and Canada spent one week in 

intensive study of traffic signal control systems. Extensive use was made of the CID and HILS 

technologies during the workshop. 

In 2005, the UI partnered with PTV America, Econolite, Purdue University, and others to 

develop a software-in-the-loop simulation (SILS) environment and a curriculum of 37 laboratory 

experiments in which students could learn about traffic control systems by observing both traffic 

flow conditions and traffic control processes. This product, both the simulation environment and 

the curriculum, is known as MOST (Mobile Signal Timing Training). MOST, funded through the 

Federal Highway Administration, consists of a simulation environment and an accompanying set 

of 37 laboratory experiments in which students can visualize traffic flow and controller timing 

processes as they learn how traffic control systems operate. Figure 1 shows an example 

screenshot from a MOST animation in which students view two conditions (low volume on the 

left and high volume on the right) to learn how a phase times and terminates.  
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Figure 1: Example MOST visualization of traffic flow and timing processes. 

 

Figure 2 shows example text from one of the MOST laboratory experiments, including the 

learning objectives, an overview of the experiment, the questions that students will consider 

when they have completed the experiment, and the steps that they will follow during the 

experiment. 

 

 

Figure 2: Excerpt from MOST curriculum. 
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The UI is now leading a five member consortium to develop a set of active-based learning 

courses on transportation. The University of Idaho team has developed and tested a one semester 

course in traffic signal timing based on two books, one on isolated intersections and the other on 

coordinated signal systems. This project is funded through the Federal Highway 

Administration’s Transportation Education Development Pilot Program. The first book includes 

65 activities, some based on the MOST experiments described above and others using field data 

and observations to better understand traffic signal systems. The culminating activity in both 

cases is a signal timing design that is developed and tested using VISSIM. Static visualizations 

of controller operations are provided through the use of the Traffic Control Process Diagram 

illustrated here in Figure 3.  

 

Figure 3: Traffic Control Process Diagram. 

 
VISSIM Simulation Environment 

The visualization environment that was used in the MOST project and the FHWA TransEd 

project is based on the VISSIM micro-simulation model. VISSIM is a microscopic traffic 

simulation model that has been in use throughout the world for more than twenty years. It 

provides sophisticated modeling of driver behavior, roadway geometry, and traffic control 
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systems (both signal and stop controlled) to produce a realistic animation of arterial systems and 

intersections, as well as a rich array of quantitative data that can be used to describe the 

operations and performance of a traffic system. Figure 4 shows a standard VISSIM window of a 

traffic simulation. Visible are the vehicles, the detection zones, and the signal heads (showing the 

display color). VISSIM is a mature simulation and animation model that, in addition to the 

animation, produces a rich set of detailed (microscopic) vehicle, detector, signal timing, and 

display data.  

 

Figure 4: Standard VISSIM simulation window. 

 
The MOST experiments are currently limited to a two-dimensional representation of traffic flow; 

this limits the realism of the display. The signal controller display used in MOST (the status 

display screen of the ASC/3 controller) shows a sometimes overwhelming amount of data that is 

changing in real time. It is sometimes difficult for the student to focus on the critical areas of the 

display screen. 

Figure 5 shows a VISSIM simulation with an evaluation window that includes the signal displays 

(display color shown over time) and detector status (on/off sequences over time). The window 

follows this information as the simulation is run enabling the user to more clearly visualize how 

these two important processes are related to the traffic flow. The user can also follow the signal 

status display for one type of traffic controller, the Econolite ASC/3. Here the user can observe 

the active phase, the vehicle and pedestrian calls, and the timing processes for each ring in a 

tabular format over time. 
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Figure 5: Standard VISSIM window with other visualization information. 

 
Figure 6 shows four other tables that can be viewed during a VISSIM simulation including 

vehicle specific data, travel times, signal changes, and timer and detector records. While each of 

these windows shows important data that can be viewed during the simulation, the tabular format 

makes it difficult to integrate the richness of the data (including the state of the system and 

aspects of its performance) for most users.  

 

 

Figure 6: Standard VISSIM window with evaluation windows. 

 
New Work 

Based on the previous work conducted at the University of Idaho described above, the project 

team has developed the following materials and tools: 
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 A prototype of a new visualization tool called TrafficSense. One form of the prototype is a 

standalone tool that uses post-processed VISSIM data while the second form is one that can 

run with VISSIM in real time producing an array of new visualizations. 

 The tools have the ability to show performance measures including delay, alongside the 

vehicle and timing processes, alternative visual displays of these data flows to include more 

complex conditions such as the flows and timing data for an entire intersection or a system of 

intersections, and visual displays that represent traffic flow at an intersection that includes an 

adjacent rail line (so that preemption can be displayed). 

 A complete curriculum for railroad preemption operation that can be integrated with VISSIM 

and the TrafficSense visualization tool. 

 Basic operational material on volume/density control and control using the dynamic max 

signal setting that can be used for future curriculum materials. 

 The concept of the canvas, a visual representation that can be used to develop curriculum for 

coordinated traffic signal systems. 

Chapter 2 of this report describes the curriculum that was developed. Chapter 3 describes the 

development of the prototype standalone TrafficSense tool, one that uses post-processed VISSIM 

data. Chapter 4 describes the real time version of TrafficSense, runs with VISSIM through the 

COM module. Chapter 5 provides a summary of the conclusions and the next steps. Appendices 

include a user’s manual for TrafficSense, software documentation for TrafficSense, and an 

evaluation of the prototype TrafficSense tool. Screenshots illustrating TrafficSense are shown in 

the fourth appendix. 
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2. CURRICULUM 

Three topic areas were selected for study and curriculum development as part of this project. 

Studies of operational effects of volume/density control were completed and are available for 

future curriculum development projects. A visual environment for better understanding 

coordinated traffic control systems, known as the canvas, was developed and will be the basis for 

future curriculum development. For railroad preemption, a complete curriculum was developed 

as part of this project. The work on coordinated signal systems and railroad preemption are 

reported in this chapter. 

Coordinated Signal Systems 

The biggest challenge in learning about arterial traffic systems is that the relationship between 

the traffic processes and the resulting performance is very intricate, with many small factors 

influencing how a system operates. In addition, the technology of intelligent transportation 

systems (ITS) is constantly evolving, making it difficult for practitioners and instructors to stay 

on top of the best practices. Kyte and Brown (2009) state that “the development of new control 

systems technologies generates the need to assess how we educate transportation engineers. The 

situation today is not unlike the 1950’s when new skills in civil engineering were needed to 

design, construct, and maintain the interstate highway system. To design and operate traffic 

signal control systems, new skills in systems engineering, electronics, and communications are 

needed.”  

Despite the challenge of designing complex transportation systems, many university courses and 

agency training modules over simplify these complex concepts by using very basic scenarios to 

represent the intricacy of arterial systems. For instance, in introductory classes offered at the 

University of Idaho, “the street is represented by a straight line on which an idealized vehicle 

(point) travels at a constant speed from one signalized intersection to the next, with each 

intersection operating at a fixed cycle length (Kyte and Brown, 2009).” The crude ways that 

arterials are modeled in the required classes for freshmen and juniors fail to represent the 

environment that practicing engineers design traffic systems for, adding to the problem of “ill-

prepared” engineers entering the industry. In particular, uniform flow and fixed time systems 

with the absence of actuation are not common in reality. In order for quality learning to take 



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 12 

place, students should learn in an environment that “duplicates the environment in which 

[students] will practice transportation engineering (Kyte and Brown, 2009).” The senior level 

transportation class at the University of Idaho approaches this level of learning with the 

introduction of random flow and actuated signal operation. They show the levels of presentation 

of the complexity of arterial traffic systems at different college level courses in Figure 7. 

 Freshman Juniors Seniors Practitioners 

Flow Single Vehicle Uniform Flow Random Flow  

Geometry Single Lane Multiple Lanes   

Traffic Signal 
Control 

Fixed Time Fixed Time Traffic 
Actuated 

 

Figure 7: Added complexity for college transportation coursework (Kyte and Brown, 
2009). 

 
They identify the material that should be covered in transportation engineering teaching 

materials so that students have an adequate foundation to learn about arterials as a system. 

“To be able to effect a change, the transportation engineer must have knowledge of several 

interconnected elements that together produce the quality of traffic flow experienced by 

travelers on the city street. These elements include: 

 The composition and volume of users of the street (pedestrians, bicyclists, 

automobiles, buses, light rail trains). 

 The geometry of the intersections and the street, including the number and width of 

lanes, the presence of turning lanes, the angles in which the streets intersect, and the 

horizontal and vertical curves present on the street. 

 The method of traffic control at the intersections (stop signs, yield signs, traffic 

signals) and whether, in the case of traffic signal control, the control is coordinated 

between intersections. 

 The detection or sensor technology used to determine the presence of users at each 

intersection. 

 The kind and placement of other relevant infrastructure including lighting, signal 

displays, signage, striping, and crosswalks (Kyte and Brown, 2009).” 
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A different perspective of the challenge is to teach at a level that is easy to understand by 

including enough information without oversimplifying the material, yet being careful to not 

overwhelm the learner. Recently, efforts to meet the criteria listed by Kyte have been developed 

and tested in both the classroom and in the form of mobile learning modules. The MOST 

program and its predecessor, the “one-week hands-on summer workshop on traffic signal design 

and operations” (Kyte and Brown, 2009), have shown “an increase in the level of interest in 

transportation and a significant degree of improvement in signal timing design skills (Kyte, 

2009, and Kyte, Dixon, Abdel-Rahim, Brown, 2009). The MOST program laid the groundwork 

for providing learners with an environment that both displays the inner workings of traffic 

controllers, and immediately reveals the effects of variable traffic timing plans in simulated 

traffic models. MOST is the closest learning environment to actual field controllers, where 

learners can experiment with the multitude of controller settings and witness their effect on 

arterial systems. Though the MOST program has been successful, more structure needs to be 

added regarding learning the relationships between the controller processes, traffic, and the 

overall system performance. 

Sherman (2011) identified ways in which arterial signal system operation and performance can 

be described and integrated so that students and professionals can better understand both how the 

system operates (its various components) and how it is performing. The integration of various 

kinds of information (written descriptions based on observations, visual displays both static and 

dynamic, and numeric data) that will provide students with a deep understanding of system 

operation and performance is emphasized in this work. A case study is presented of an arterial 

that consists of three signalized intersections. Three operation modes are considered that 

illustrate system operation and performance including fixed time free operation, fixed time 

coordinated optimized, and actuated coordinated with floating force-offs. The operation and 

performance of each case study were analyzed with the aforementioned visual displays and 

numerical data, and conclusions are drawn about how important transportation engineering 

concepts reveal themselves in these media. One tool central to this work was the development of 

the “canvas concept.” The canvas is a versatile tool that is intended for educational use in 

university level transportation courses. The canvas is divided into four elements: operations, 

physical representations, traffic view, and performance. These elements were defined as the 

major components of an arterial traffic system and thus the canvas is a visual representation of 
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each component. The canvas also shows links between the elements, with each link representing 

one way to visualize a relationship between the elements. The process of seeing and describing 

the links between elements results in learning more about how complex traffic systems operate 

and perform.  

Railroad Preemption 

There are numerous state and federal agencies that operate traffic control systems that include 

railroad preemption. However, it is generally agreed that many of these agencies do not have 

sufficiently trained staff to design a safe, effective, and efficient railroad preemption phase. The 

currently available materials do not provide a comprehensive tool for learning the concepts and 

relationships present in railroad preemption. This lack of available information results in railroad 

preemption phases that are not designed properly and may put the public in danger. A more 

comprehensive learning tool is clearly needed to teach the process of railroad preemption.  

The goal of this report is to present a new curriculum and the supporting visual tools that will 

provide both university students and practicing professionals with a means to better understand 

the railroad preemption process. The materials presented in this report provide an overview of 

the process of railroad preemption as well as visual based learning tools to develop complicated 

concepts.  

Campbell (2011) created an activity-activity based curriculum for teaching the process of 

railroad preemption to students and professionals. This activity-based curriculum uses visual 

tools to communicate intricate and often confusing concepts related to the process of railroad 

preemption. This thesis includes ten chapters. The first chapter provides an introduction to the 

topic of railroad preemption, justification of the approaches taken using activity-based learning 

and visualization, the general method followed in TrafficSense, and the problem statement and 

methodology used to create the curriculum. Chapter 2 provides an overview of the railroad 

preemption process and describes the learning objectives and activities developed for each 

chapter. Chapters 3 through 10 consist of the 31 activities that were developed. The 

visualizations and materials contained in these eight chapters provide a tool for students to learn 

about the process of railroad preemption. Chapters 8 through 10 provide design problems that 

students can complete to apply their knowledge gained from the curriculum. The solutions to 
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each of the 31 activities, from which an instructor guide can be established, are included in the 

appendix. 

The activities created present a process that students can follow to learn about the railroad 

preemption process. The activities consist of five main components: 

 Purpose – presents a general overview of the topic addressed in the activity 

 Learning Objectives – identifies the major concepts that should be taken from the activity 

 Required Resources – any additional materials that are needed to complete the activity, 

this may include videos, tables, graphs, readings, or computer software 

 Questions to Consider – major points that should be considered and focused on when the 

activity is being performed 

 Tasks – components that must be performed to complete the learning objectives of the 

activity 

The layout of the activities was developed to facilitate the student and the instructor in the 

learning process. The activities developed in the curriculum provide an outline for teaching and 

learning the concepts associated with railroad preemption. 

The TrafficSense event timer (Figure 8) displays the major events and processes of preemption 

as they occur in real time. The event timer lines up with the detector, signal, and timer displays 

and progresses with the simulation. With the presence of the event timer, it is possible to 

visualize the entire preemption process as it occurs as well as view the upcoming events. 

TrafficSense provides a very useful tool to aide in the understanding of railroad preemption and 

would be a useful supplement in the learning process. 

 

 

Figure 8: TrafficSense railroad preemption event timer. 
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3. TRAFFIC SENSE – CONCEPTS AND PROTOTYPES 

In September 2009, teams of students from the University of Idaho’s Departments of Civil 

Engineering and Virtual Technology Design (VTD) began to develop tools and example 

curricula to enable transportation engineering students to more effectively learn about traffic 

signal control systems. The teams developed a series of prototypes that provided unique ways of 

visualizing processes that operate simultaneously: traffic flow patterns, traffic detectors, signal 

timing processes, signal displays, and performance measures. The teams focused their work on 

four control types: standard actuated traffic control, volume density control, signal coordination, 

and railroad preemption. 

During Spring 2010, as part of VTD’s junior studio, the team developed four prototypes, each 

subject to intense review by the team members. Examples of the prototypes are shown in Figure 

9. Each of the visual representations shown in Figure 9 show a maturing of the students’ 

understanding of the processes and how different visual representations can tell a different story 

of traffic control systems. For example, the first prototype developed by the students showed 

only the traffic control processes themselves. Representations of traffic flow were added in the 

second prototype. Flexibility in moving and re-arranging the various elements of the 

visualizations were added in the third and fourth prototypes. For each of the representations, the 

team members used output data from the VISSIM simulation model to create the traffic flow and 

control processes. 

 

Figure 9: Prototypes from Spring-Summer 2010. 
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During the second year of the project, coinciding with VTD’s senior design studio, the student 

teams (consisting of Bryan Foutch, Devin Abolins, and Jake Lauer) experimented with several 

new displays, including adding time slicer functions, a more dynamic visual environment, and 

showing multi-dimensional data that could be added to the VISSIM output data. Examples of 

these displays are shown in Figure 10.  

 

 

Figure 10: Prototypes from 2010-2011 academic year. 

 

The final product, TrafficSense, was completed in time for presentation to the NIATT advisory 

board meeting and the University of Idaho Engineering Expo, held in April 2011. The Traffic 

Sense tool combines six displays that all operate together. The main window (center of Figure 

11) shows a representation of traffic flow during a railroad preemption sequence. The detection, 

timing, and displays are shown in the left portion of the figure. A time space diagram for the 

northbound vehicles is shown at the right. On the lower portion of the figure, various elements of 

the control process elements are shown in sequence.  
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Figure 11: TrafficSense. 

 
Two other examples from the final version of the TrafficSense prototype illustrate other 

information that can be displayed. Figure 12 shows an example of two intersections operating in 

coordination. In addition to the other information already described, the Purdue Coordination 

Diagram is shown for one cycle in the upper right of the figure. And Figure 13 shows railroad 

preemption with a train running just to the east (right) of the intersection shown. In addition, in 

the bottom of the figure, the preemption processes and their duration are shown for each of these 

processes. 
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Figure 12: TrafficSense prototype showing signal coordination. 

 
 

 

Figure 13: TrafficSense showing railroad preemption.   
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4. REAL TIME TRAFFICSENSE –CONCEPTS AND PROTOTYPES 

Tool Specifications 

A second approach to the visualization tool development is a real time tool that runs as part of 

the VISSIM simulation model. While there are a number of possible ways to display these data 

and information, one set of views that could replace the existing VISSIM evaluation windows is 

described here, along with a description of the data required to realize these views. The views, in 

combination with the animation that is the main visual element of VISSIM, provide a much 

richer view of traffic signal operations, particularly for students who are learning about how such 

systems work. 

The five evaluation windows are: 

 Phase Timing window 

 Performance window 

 Time-Space Diagram window 

 Purdue Coordination Diagram window 

 Event Diagram window 

Phase Timing Window 

One of the important elements of TrafficSense, as well as the previous work contained in the 

MOST project, is the ability of the user (student) to see the interrelationships between the traffic 

flow, the detector status, the basic actuated timing processes, and the signal displays (and then 

the feedback to the traffic flow). The interrelationships were captured in a static way in the 

Traffic Control Process Diagram shown earlier in Figure 3. An example of the proposed Phase 

Timing Window is shown in Figure 14. 

The Phase Timing Window is built with timing data that is now available in VISSIM’s LDP file 

for the ASC/3 controller and the RBC controller, through a funded request from the University of 

Idaho to PTV. While only the three of the most common actuated timing parameters (minimum 

green time, passage time, and maximum green time) are shown, it is possible to build flexibility 

into this window and show other timing processes such as those related to volume/density 

control, signal coordination, and railroad preemption. The detector status data and the signal 
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display data are available from VISSIM’s LDP file. The proposed layout for this window 

communicates signal timing process data in a far more useful and appealing way than either the 

current Signal Times Table view or the tabular views available in the current version of VISSIM. 

The Phase Timing Window could consist of several parts that would be combined into a single 

display (as per Figure 14) or “undocked” and available to be moved around at the discretion of 

the user. The user should also have the ability to select which phases to display, based on the 

topic of a particular study. 

 

Figure 14: Phase Timing Window. 
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Performance Window 

VISSIM provides a rich set of text files that describe performance at the system, intersection, and 

approach levels using such measures as delay, vehicle stops, travel time, and queue length. The 

ability to view performance during the simulation allows a student to gain deeper insights to be 

drawn as the user is integrating his or her understanding of the system functions and the resulting 

performance. Figure 15 shows an example of real time displays of two of these measures, queue 

length and delay over time. Here the user can see the variation in queue length that is often 

displayed in the form of a Queue Accumulation Polygon, a fundamental tool now used in the 

2010 version of the Highway Capacity Manual. Other measures can be included for different 

approaches or intersections, with data from VISSIM’s KNA file. 

 

 

Figure 15: Performance Window. 

 
Time-Space Diagram Window 

A third type of display is the Time-Space Diagram Window, which shows vehicle trajectories 

over time and distance, as vehicles travel along an arterial or through an intersection. The 

example shown in Figure 16 from TrafficSense is color coded using attributes such as vehicle 

speed, headway to the leading vehicle, or vehicle type. The Time-Space Diagram Window is 

constructed using data from VISSIM’s FZP file. 
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Figure 16: Time-Space Diagram Window. 

 
Purdue Coordination Diagram 

There are other ways of displaying system operation, including an innovation developed by 

Purdue University and the Indiana Department of Transportation. Known as the Purdue 

Coordination Diagram, Figure 17 shows the arrivals of vehicles at a point just upstream of an 

intersection (beyond the farthest extent of the queue that forms during red) during the simulation 

time (x-axis) over each cycle (on the y-axis). The display status is also shown so that the user can 

immediately see trends on whether most vehicles arrive during red (poor coordination) or during 

green (good coordination), or whether an obvious problem exists in the cycle length for a given 

intersection that is part of a coordinated system. Other innovative displays could also be shown. 
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Figure 17: Purdue Coordination Diagram. 

 
Event Diagram 

The event diagram shows the primary signal timing processes for basic actuated control, volume-

density control, signal coordination, and railroad preemption. It is a broad overview of the entire 

timing and control process. 

Overall Representations 

The various diagrams can be represented in different ways to provide a coherent view of the 

system operation and performance. The standalone version of the TrafficSense prototype 

includes a combined view with six different windows, as shown in Figure 11, Figure 12, and 

Figure 13. A new version of VISSIM might include a similar set of views arranged on the 

periphery of the animation (see Figure 18) or placed flexibly at the discretion of the user (as 

shown in Figure 19). 
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Figure 18: Multiple views of traffic control system operation and performance (option 1). 

 

 

Figure 19: Multiple views of traffic control system operation and performance (option 2). 
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More specific information for the requirements of this real time tool is described now for each of 

the following windows. 

 Phase Timing window 

 Performance window 

 Time-Space Diagram window 

 Purdue Coordination Diagram window 

 Event window 

The discussion for each window includes: 

 the current VISSIM display, if any 

 the layout of the proposed window 

 the parameters required and the files that currently generate them 

 user actions required to select the parameters 

 calculations needed to produce the data that will be displayed in the new evaluation window
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Phase Timing Window 
Current view 

VISSIM currently displays the signal display for each 
signal group and the status of each detector using the 
Signal Times Table evaluation window. This display is 
shown below, with examples for the display for two 
signal groups and the detector status for three detectors. 
[The SC/Detector Record window shows a tabular view 
of these same data.] 

Proposed view 

The proposed Phase Timing evaluation window is 
shown below. The proposed window shows a more 
complete view of the signal timing control processes 
including the simulation time, the detector status, the 
three primary actuated timing processes (minimum 
green, passage time, and maximum green) and the signal 
display. 

Parameters 

The Phase Timing evaluation window would be produced with the variables that are now part of the LDP file. The 
values to be stored in the LDP file are selected by the user and this process could be followed to create the new 
Phase Timing window. 

Parameter Name Additional Information 

Simulation time  
Detector status Detector number 
Minimum green Rings 1 through 4 
Passage time (vehicle extension time) Rings 1 through 4 
Maximum green Rings 1 through 4 
Signal display Phases 1 through 8 
Active phase Rings 1 through 4 

 

User actions 

Users must select the timing parameters and the phase (signal group) number to be displayed. 

Calculations required 
No intermediate calculations are needed to determine the data required for the Phase Timing window. 

Other issues 

 How many phases (signal groups) should be displayed at the same time? 
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Performance Window 
Current view 

VISSIM provides a rich set of text files that describe 
performance at the system, intersection, and approach 
levels using such measures as delay, vehicle stops, 
travel time, and queue length. The only view available 
when the simulation is running is a tabular view of the 
travel times, shown below. 

 

 
 

Proposed view 

However, to be able to view system performance during 
the simulation allows deeper insights to be drawn as the 
user is integrating his or her understanding of the system 
functions and the resulting performance. The figure below 
shows an example of real time displays of two of these 
measures, queue length and delay over time. Here the user 
can see the variation in queue length that is often 
displayed in the form of a Queue Accumulation Polygon, 
a fundamental tool now used in the 2010 version of the 
Highway Capacity Manual. Other measures can be 
included for different approaches or intersections, with 
data from VISSIM’s KNA, KNR, RSR, and RSZ files. 

Parameters 

The Performance evaluation window would be produced with variables from the RSR and/or RSZ when travel time 
segments have been created, or KNA and/or KNR files when a node has been created at an intersection. If the KNA 
file is used, average values over small time intervals (such as 10 seconds) are displayed; if the KNR file is used, 
values for each vehicle are displayed at the time that the vehicle either entered or departed from the node. The values 
to be stored in these files are selected by the user. Either average (RSZ) or instantaneous (RSR) travel times can be 
displayed. 

Parameter Name Additional Information 

tStart  
tEnd  
Node  
Delay  
tStopd  
aveQueue  
Node  
Movement  

 

User actions 

Users must select the travel time section or the intersection node to be displayed as well as the performance measure 
(delay, stops, queue length). 

Calculations required 

No intermediate calculations are needed to determine the data required for the Performance window. 

Other issues 

 How many nodes or segments should be displayed at the same time? 
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Time Space Diagram Window 
Current view 
None. 
 

Proposed view 

A third type of display is the Time-Space Diagram 
window, which shows vehicle trajectories over time and 
distance, as vehicles travel along an arterial or through an 
intersection. The example shown below is color coded 
allowing visualizations of attributes such as vehicle speed, 
headway to the leading vehicle, or vehicle type 

 

Parameters 

The Time-Space Diagram window would be constructed using data from the FZP file. Depending on the orientation 
of the intersection, a combination of the World X and Y coordinates would be used to specific the vehicle position, 
the y-axis of the chart. The simulation time would be used for the x-axis. Vehicle attributes such as acceleration, 
velocity, and time in queue could also be displayed as the color of the vehicle trajectory line. 

Parameter Name Additional Information 

Simulation time  

Vehicle number  

World X coordinate  

World Y coordinate  

Link  

Lane  

Acceleration  

Velocity  

Time in queue  
 

User actions 

Users would specify the Vehicle Record evaluation file and select the parameters listed above. The link number and 
lane number of interest would also have to be selected. The method of specifying the link and lane numbers must be 
determined but could include graphically selecting a link (as currently done to specify a vehicle when displaying 
vehicle information) or by specifying the link or lane in the evaluation window configuration. 

Calculations required 

No intermediate calculations are needed to determine the data required for the Time-Space window. 

Other issues 

 How many time-space windows should be specified at the same time? 
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Purdue Coordination Diagram Window 
Current view 
None. 
 

Proposed view 

There are other ways of displaying system operation or 
performance, including an innovation developed by 
Purdue University and the Indiana Department of 
Transportation. Known as the Purdue Coordination 
Diagram, the figure below shows the arrivals of vehicles 
at a point just upstream of an intersection (beyond the 
farthest extent of the queue that forms during red) during 
the simulation time (x-axis) over each cycle (on the y-
axis). The display status is also shown so that the user can 
immediately see trends on whether most vehicles arrive 
during red (poor coordination) or during green (good 
coordination), or whether an obvious problem exists in 
the cycle length for a given intersection that is part of a 
coordinated system. Other innovative displays could also 
be shown. 

 

Parameters 

The Purdue Coordination Diagram Window is constructed using data from VISSIM’s LDP file. The simulation time 
is plotted on the x-axis while the cycle second (time during the cycle) is plotted on the y-axis for each activation of 
the state detector (which is placed upstream of the signal, beyond the extent of the standing queue). The display 
color is also displayed for each portion of the cycle, as shown above. 

Parameter Name Additional Information 

Simulation seconds  
Cycle seconds  
State Detector  
Display  

 

User actions 

Users must select the link (approach) for which the Purdue Coordination Diagram will be displayed. 

Calculations required 
None. 
Other issues 

 How many diagrams should be displayed at the same time? 
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Event Timeline Window 
Current view 
None. 
 

Proposed view 

The Event Timeline window shows the primary signal 
timing processes for basic actuated control, volume-
density control, signal coordination, and railroad 
preemption. It is a broad overview of the entire timing 
and control process. The example illustrated below shows 
part of a railroad preemption process. 

 

Parameters 

The Event Timeline window is constructed using data from VISSIM’s LDP file. The window includes most of the 
data available in the LDP file, based on the events that the user desires to show. 

User actions 

Users must select the events that they desire to show in the window. 

Calculations required 

Some calculations are required to show the beginning and end points of the events to be illustrated. 

Other issues 

 The format and extent of the Event Timeline needs to be determined. 

 

Prototype Implementation 

As part of this project, a team from Georgia Tech University developed anext-generation 

visualization tool for traffic signal control systems. The first generation TrafficSense uses post-

processed VISSIM data to visually study isolated intersections, coordinated signal systems, and 

the railroad preemption process.  

This prototype was developed to provide traffic simulation outputs graphically during runtime by 

interfacing with PTV VISSIM. The program utilizes the COM interface provided by VISSIM 

and performs computations to draw various graphs depicting the traffic state. This program 

currently provides the following graphical outputs: time space diagram, average travel time, 

number of vehicles, average delay, and queue length. Currently under development are the 

phase-timing window and Purdue Coordination Diagram window. 

This program is written in C# with Silverlight as the UI framework. The software uses MVVM 

(Model-View-ViewModel) design pattern where views contain all the information about the 
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layout of UI elements and their binding with the backend logic. View model contain all the logic 

of the software and how the data from VISSIM COM must be converted into objects that the UI 

can read and render as graphs.  

Architecturally, the design can be depicted as in Table 1: 

Table 1: Architectural View 

Main View 

Time-space view Performance 
view 

Purdue view Phase time view … 

Time space view 
model 

Performance 
view model 

Purdue view 
model 

Phase time view 
model 

… 

Base View Model 

 
The class diagram and file organization are shown in Figure 20 and Figure 21: 

 

Figure 20: Class diagram. 
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Figure 21: File organization. 

 
Input (using the browse button to navigate and select the desired files on the program window). 

1. VISSIM inp file 
2. Links to monitor (two opposite directional links can be selected) 
3. Time period and resolution (optional) 
4. Window size (optional) 
5. Zoom in (optional) 
6. Data collection point (pre-defined in INP file / for performance graph only) 

The time space diagram is illustrated in Figure 22. The colored lines indicate the signal states as 

being RED, GREEN or AMBER whereas the black lines indicate each vehicle trajectory. The 

current plot separates opposing directions of travel on the graph.  
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Figure 22: Time space diagram. 

 
Figure 23provides an example of the performance graphics. In the current version travel time and 

delay are plotted as a vehicle exits a data collection segment.  

 

Figure 23: Performance graphics.  
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5. CONCLUSIONS  

This report presents the results from a project that developed both curriculum and prototype 

visualization tools to aid students and engineers in learning more about traffic signal control 

systems. New curriculum and support material were developed for volume/density control, 

coordinated traffic signal systems, and railroad preemption. Prototype visualization tools were 

developed for both post-processed data and for real-time simulation. 

So, what is the impact of this work? What are some of the directions for future development of 

this work? What are some of the challenges as this work moves ahead? Four such issues, 

forming the basic conclusions from this research, are briefly described below. 

1. It is possible to develop visualization tools that illustrate traffic signal control processes in 

rich and informative ways. Through a multi-disciplinary collaboration between two programs 

at the University of Idaho (the National Institute for Advanced Transportation Technology 

and the program for Virtual Technology Design), a prototype visualization tool was 

developed. This tool, TrafficSense, illustrates the mutual interaction of traffic flow and traffic 

control processes. Traffic control processes including detectors, control timers, and displays 

are shown in various ways and levels of detail. Campbell (2011) and Sherman (2011) each 

showed how the TrafficSense prototype could be used to illustrate railroad preemption and 

signal coordination processes. The Virtual Technology Design team showed various visual 

prototypes for illustrating elements of traffic flow using post-processed data from the 

VISSIM simulation model. The Georgia Tech team showed both time space views and traffic 

signal control process views using VISSIM data in a real-time mode. These prototypes 

provide both aspirational and concrete views of what is possible.  

2. Development of such visualization tools is a complex and difficult process. While the 

development of prototype-scale tools is the first step in the formal software development 

process, determining how this development process can be sustainable is a difficult question 

to answer. The project explored two possible options in this regard. The first was based on 

turning over these concepts to a private developer. This option was explored, based on 

discussions with one private sector simulation model developer. Unfortunately, the developer 

was not in the appropriate place in its product development cycle that would allow for the 
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incorporation of the ideas imbedded in TrafficSense. The second was based on continued 

university development. It is likely that the George Tech University team, who assisted with 

one of the prototype versions of TrafficSense, will continue with this work, enabling a 

continued enhancement of TrafficSense. Future such work must clearly define software 

development objectives and professional management and development processes so that a 

sustainable tool can result. 

3. These visualization tools can improve the understanding of complex processes. Initial studies 

of the effect of improved transportation visualization tools have shown that visualization can 

enhance the learning process and understanding for transportation engineering students. 

Anecdotal evidence from the delivery of the MOST curriculum and visualization tools 

resulted in a more comprehensive and realistic understanding of traffic control processes 

(Kyte, Dixon, Abdel-Rahim and Brown, 2009). Nicholas (2011) showed that since most 

people are visual learners, animations of traffic control processes can be useful in illustrating 

complex traffic control processes, more so than static representations of such processes. 

However, much more work is needed in this area. For example, what is important about the 

traffic control “scene”, and what do professional transportation engineers “see” when they 

are in the field observing traffic flow? Particularly important is what engineers see or observe 

about traffic flow and how they relate these observations to the traffic controller, which they 

can “see” by looking into the traffic control cabinet. What is important about both that the 

professional knows implicitly after years of experience and what the inexperienced student is 

trying to learn? How can students learn the process of integrating the visual representations 

of traffic flow with the quantitative data that they are able to collect through simulation 

models or field observations? What is ultimately important to both the professional and the 

student as they make choices about the design of the traffic control system? And, how can 

the model of traffic control systems be presented in increasing levels of realism from an 

initial view of fixed time control and uniform traffic flow, to a more realistic (and complex) 

view of actuated or responsive traffic control and non-uniform traffic arrival processes? 

These questions are important ones to consider in future work in this area. 

4. Curriculum must lead the development of visualization tools. One of the critical perspectives 

of this project has been that curriculum, in its various forms, must be based on sound 

pedagogy. One of the underlying theories used in this project is that of Wiggins and McTighe 
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(1999), in which learning objectives and the evidence that will be used to determine whether 

these learning objectives have been met must be established before any curriculum materials 

are developed. And, the visualization tools must have the context of the learning objectives 

and curriculum materials. If the student is to learn about signal timing processes, the content, 

what is to be learned, must first be developed before tools to visually illustrate these 

processes are designed. And, what is learned from the application of the visualization tools 

(such as in the study by Nicholas, 2011) must in turn be fed back into the curriculum 

development process. Campbell (2011) illustrated how this process can be done jointly, 

through the development of learning objectives, activities that can be completed by students, 

and applications of the TrafficSense prototype using VISSIM. 

The use of visualization tools in transportation education is an exciting area, and one that is 

guaranteed to develop in interesting and novel ways over the years. Consider the game-changing 

area of electronic textbooks, such as Apple’s iBook textbook initiative in which animations and 

other tools can be integrated directly into a book itself. And consider the massively open online 

courses that are now being developed at several universities in which courses are delivered to 

thousands, or hundreds of thousands, of students at a time via the Internet. Finally, consider the 

National Transportation Curriculum Project, in which a number of transportation educators 

throughout the U.S. are working collaboratively to develop activity-based curriculum for the 

introductory transportation engineering course. Clearly, there is much to do in this exciting area! 

 

 

  



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 38 

REFERENCES 

Brown, J.S., A. Collins, and P. Duguid (1989). Situated Cognition and the Culture of Learning. 

Educational Researcher, 1989. 18 (1): p. 32-42. 

Campbell, S. (2011). “A Deeper Understanding of the Railroad Preemption Process: 

Development of Activity-Based Learning Curricula and Visualization Tools”, Master’s Thesis, 

University of Idaho, December 2011. 

Kyte, M., G. List, D. Bullock, M. Dixon, and M. Trevisan. (2002) “Transportation Engineering 

Field Problems”, proposal to the National Science Foundation, Washington, D.C. 

Kyte, M., S. Brown, and R. Bertini (2007). “Pedagogies to Improve Learning Outcomes in 

Transportation (PILOT)”, proposal to the National Science Foundation, Washington, D.C. 

Kyte, M. and S. Brown (2009). “UDOCS: Student and Practitioner Understandings of the Design 

and Operation of City Streets”, proposal to the National Science Foundation, Washington, D.C. 

Kyte, M. (2009). MOST-A Hands on Approach to Traffic Signal Timing Education  Retrieved 

May 1, 2012, 2012, from http://www.webs1.uidaho.edu/most/. 

Kyte, M., Dixon, M., Abdel-Rahim, A., & Brown, S. (2009). “A Process for Improving the 

Design of Transportation Curriculum Materials with Examples”, Transportation Research 

Record, 2199 (2010), 18-27. 

Leonard, W. J., Gerace, W. J., Dufresne, R. J., & Mestre, J. P. (1999). “Concept-based problem 

solving,” U. Mass, Dept. Physics and Sci. Reason. Inst, 

http://umperg.physics.umass.edu/gemsFolder/umperg2/umperg_1999_12.pdf. 

Liao, C.-F., H. Liu, and D. Levinson (2009). “Engaging Undergraduate Students in 

Transportation Studies through Simulating Transportation for Realistic Engineering Education 

and Training (STREET)”, in Annual Meeting of the Transportation Research Board. 2009: 

Washington, D.C. 



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 39 

McDermott, L.C. (1993). “How We Teach And How Students Learn- A Mismatch?”, American 

Journal of Physics 61(4): 1993. Available at 

http://unr.edu/homepage/jcannon/ejse/mcdermott.html.  

Mestre, J.P. (1994). “Cognitive Aspects of Learning and Teaching Science,” Teacher 

Enhancement for Elementary and Secondary Science and Mathematics: Status, Issues and 

Problems, S. J. Fitzsimmons & L. C. Kerpelman, ed. Washington, D.C.: National Science 

Foundation, pp. 3-1, 3-53. (NSF 94-80). 

Murray, M. H. (2001). “Students: Managing to Learn; Teachers: Learning to Manage,” Ch. 9 in 

Student-Assisted Teaching: A Guide to Faculty-Student Teamwork, Miller, Groccia & Miller. ed. 

Boston: Anker, 2001. 

Nicholas, Chelsea (2011). “Evaluating the Effectiveness of Dynamic Traffic Simulations: A 

Case Study in Transportation Engineering Education”, Master’s Thesis, Washington State 

University, December 2011. 

Prinz, J.J. (2004). “Furnishing the Mind: Concepts and Their Perceptual Basis”. 2004, 

Cambridge, MA: the MIT Press. 

Redish, E.F. and K.A. Smith (2008). “Looking Beyond Content: Skill Development for 

Engineers”, Journal of Engineering Education, 2008. 97(3): p. 295-307. 

Sherman, D. (2011). “Development Of Tools To Understand And Visualize The Operation Of A 

Coordinated Arterial Traffic System”, Master’s Thesis, University of Idaho,  December 2011. 

Wales, C. E (1989). “Thinking about Thinking about Thinking,” Center for Guided Design 

Newsletter, Morgantown, WV: West Virginia University,. Dec. 1989, p.9. 

Wales, C.E., Nardi, A.H., Stager, R.A. (1989). “Teaching Thinking Skills: Research Supports 

Experience,” Center for Guided Design Newsletter, Morgantown, WV: West Virginia 

University, 1989. 

Wiggins, G., & McTighe, J. (1999). Understanding by Design. Englewood Cliffs, NJ: Prentice-

Hall.  



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 40 

APPENDIX 1 – TRAFFIC SENSE USER’S MANUAL 

Getting Started 

Installing and opening TrafficSense 

The TrafficSense application is based on Adobe’s AIR runtime. AIR must be installed before 

TrafficSense can be installed. If you do not already have AIR installed, visit 

http://get.adobe.com/air to download and install AIR before continuing. 

Once AIR is installed, complete the following steps to install TrafficSense: 

1. Locate TrafficSense.Air 

2. Open TrafficSense.Air and follow the steps ( Install > Continue ) 

 
3. TrafficSense should now be installed. 
4. TrafficSense can now be opened from: 

a. A shortcut from the desktop (if this option was chosen during installation) 
b. A shortcut from the Start Menu 
c. TrafficSense.exe in Program Files (usually C:\Program Files (x86)\TrafficSense 

or C:\Program Files \TrafficSense) 
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Creating a simulation 

1. Open TrafficSense 
2. Click File > New Simulation 

 
3. Select a scenario, either “Standard Timing”, “Railroad Preemption”, “Volume 

Density”, or “Signal Coordination” 

 

4. After using VISSIM to generate the necessary input files (see VISSIM configuration), 
click Import Data. 

 

5. Navigate to the folder output by VISSIM and click OK. 
6. TrafficSense will now import all required data. If this seems to freeze, leave it how it 

is, and it should eventually finish importing. If any of the items in the list turn red, the 
data for that item was not found and must be re-exported from VISSIM.  
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7. Once finished, TrafficSense will automatically transition into its presentation view. 

Opening an existing simulation 

1. Open TrafficSense 
2. Click File > Open… 

 

3. Locate a previously saved .XML, click on it, and click “Open” 
4. TrafficSense will load the file and automatically transition into its presentation view. 

Saving a simulation 

1. To save a simulation, TrafficSense must be open with assets already loaded. It must 
be in presentation view. 

2. Click File > Save As… 
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3. Determine the location you would like to save the file.  

Using TrafficSense	

Parts of the display 

Trends	

 

The trends view is displayed along the left side of TrafficSense. It displays data from the 

simulation, grouped by phase. By default, the trends view doesn’t display anything until a phase 

link is clicked. Once a link is clicked, the trends for that phase will display. 

The blue line shown vertically on the trends pane marks the current time of the simulation. It can 

be dragged to the left to reveal more future data, or to the right to reveal more historical data.  
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Map	

 

The map view is a geographical view of the intersection including cars, links, connectors, 

detectors, and signal displays similar to the VISSIM simulation map. Unlike VISSIM, cars and 

links can be clicked on to reveal more information. 

Event	Timeline	
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The event timeline displays states and events related to the simulation. States are indicated by a 

colored line, bookended by triangles to indicate the starting and ending times for the state. 

Current states and events are highlighted and bolded. 

Time/Space	and	Purdue	Coordination	Diagrams	

 

The time/space diagram shows vehicles as they travel along a corridor. The x-axis is time, and 

the y-axis is space, or distance travelled. A steep line indicates that a vehicle is travelling 

quickly. A horizontal line indicates that a vehicle has fully stopped. Once a link is selected, 

hovering over or clicking on a vehicle on the map will highlight that vehicle’s line on the 

time/space diagram. Highlighting multiple vehicles highlights each of their time/space lines. 

The Purdue Coordination Diagram graphs vehicles as they are detected in each cycle of a phase 

in the simulation. The x-axis is time for all cycles, and the y-axis is time for each cycle 

individually. Highlighting vehicles on the map also highlights them on the Purdue Coordination 

Diagram. 
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Controlling the display 

Controlling	the	map	

Clicking on a vehicle highlights the vehicle on the map, as well as highlighting data related to the 

vehicle in the Time/Space and Purdue Coordination Diagrams. Shift-clicking additional vehicles 

highlights them as well.  

Clicking on a link highlights the link and displays data related to the link’s phase in all data 

representation areas. 

Map Controls: 

Action Target Function 

Click Vehicle Highlights vehicle 

Click Link Highlights link, displays relevant data 

Shift-click Vehicles Highlights multiple vehicles 

Cltr-click-
drag 

Map Rotates map 

Mouse scroll Map Zooms map 

Click-drag Map Pans map 
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Controlling	trends	

 

The only controllable portion of the trends pane is the blue line that represents the current time. It 

can be dragged horizontally to re-orient the graphs to show more future data or more historical 

data.  

Controlling	the	Time/Space	Diagram	

To display the time/space diagram for an entire corridor over multiple intersections, shift-click 

on the links for the corridor in reverse order (i.e. starting with the link by which vehicles leave 

the simulation and progressing toward the link by which vehicles enter the simulation).  

Annotation	mode	

Annotation Mode allows users to point out areas of a simulation by making marks on top of it. 

Once annotation mode is enabled, any part of the display can be marked.  

 

To enable Annotation Mode, go to View > Annotation Mode. 
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Possible annotations are rectangles, lines, ellipses, and arrows. Below is a chart detailing 

keyboard shortcuts for all modes. 

Action Function 

Click-drag Creates annotation for current annotation mode 

M Rectangle (marquee) 

L Line 

E Ellipse 

A Arrow 

Mouseover + delete Deletes annotation under mouse cursor 

Q Deletes all annotations 

H (hold) Allows user to interact with map while in annotation 
mode 

 

To exit Annotation Mode, go to View > Presentation Mode. 

Necessary VISSIM output files and configuration 

Multiple files are required for TrafficSense to run. The files needed are the .ino, .fzp, .ldp and 

.mer files, the configuration of these files depends on scenario you wish to run. The .ino file if 

generated during the construction of a VISSIM network. The .fzp file is created by selecting to 

Evaluation > Files… > Vehicles and then checking “Vehicle record:.” The .ldp file is created by 

going to Signal Control > Edit Controllers… > LDP Config. The .mer file is created by first 

placing a data collection point upstream of the approaches of interest. The data collection points 

should be placed as close to the signal heads as possible. The .mer file is created by going to 

Evaluation > Files… > Vehicle and then checking “Data collection:.” To correctly configure the 

.mer file simply check “Raw Data” in in the Data Collector window. 

Standard Timing 

Three file types are required for the standard timing networks: .ino, .fzp, and .ldp. 

The .ino file requires no configuration. The .fzp file configuration can be seen in Table 2. The 

.ldp file configuration can be seen in Table 3. 
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Table 2: Configuration for the .fzp File 

Parameter Desciption 

t         Simulation Time [s] 

Length   [ft] 

Head      Headway to the next vehicle downstream [ft] 

QTm       Total Queue Time Thus Far [s] 

v         Speed [mph] 

Link 
Coordinate [ft] 

Link      Number of the Active Link 

VehNr     Number of the Vehicle 

WorldX    World coordinate x (vehicle front) 

WorldY    World coordinate y (vehicle front) 

RWorldX   World coordinate x (vehicle rear) 

RWorldY   World coordinate y (vehicle rear) 

 

Table 3: Configuration for the .ldp File 

Parameter Phase number 

Simul second 

Sig Display SG 2 4 6 8  

State Det 2 4 6 8  

Min Green Timer 2 4 6 8  

Max Green Timer 2 4 6 8  

Vah Ext Timer 2 4 6 8  

 

Signal Coordination	

Four file types are required for the signal coordination networks: .ino, .mer, .fzp, and .ldp. 

The .ino and .mer files require no configuration. The .fzp file configuration can be seen in Table 

4. One .ldp file is necessary for each intersection in the coordinated network and each must be 

configured separately. The .ldp file configuration can be seen in Table 5. 
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Table 4: Configuration for the .fzp File 

Parameter Desciption 

t         Simulation Time [s] 

Length   [ft] 

Head     
 Headway to the next vehicle downstream 

[ft] 

QTm       Total Queue Time Thus Far [s] 

v         Speed [mph] 

Link Coordinate [ft] 

Link      Number of the Active Link 

VehNr     Number of the Vehicle 

WorldX    World coordinate x (vehicle front) 

WorldY    World coordinate y (vehicle front) 

RWorldX   World coordinate x (vehicle rear) 

RWorldY   World coordinate y (vehicle rear) 

	

Table 5: Configuration for the .ldp File 

Parameter Phase number 

Simul second   

Sig Display SG 1 2 3 4 5 6 7 8 

Coord Split Timer 1 2  

Coord Splitext 
timer 1 2  

Coord Status   

Forceoffs   

Local Clock   

Master Clock   

Offset   

State Det 2 4 6 8  

Min Green Timer 2 4 6 8  

Max Green Timer 2 4 6 8  

Vah Ext Timer 2 4 6 8  
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Railroad preemption	

Three file types are required for the railroad preemption networks: .ino, .fzp, and .ldp. 

The .ino file requires no configuration. The .fzp file configuration can be seen in Table 6. Two 

.ldp files are necessary for the railroad preemption networks, one for the standard intersection 

and one for the railroad crossing. The .ldp file configuration for the standard intersection can be 

seen in Table 7. The .ldp configuration for the railroad crossing can be seen in Table 8. 
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Table 6: Configuration for the .fzp File 

Parameter Desciption 

t         Simulation Time [s] 

VehNr     Number of the Vehicle 

Head      Headway to the next vehicle downstream [ft] 

QTm       Total Queue Time Thus Far [s] 

v         Speed [mph] 

WorldX    World coordinate x (vehicle front) 

WorldY    World coordinate y (vehicle front) 

RWorldX   World coordinate x (vehicle rear) 

RWorldY   World coordinate y (vehicle rear) 

Link Coordinate [ft] 

Length [ft] 

Link      Number of the Active Link 

	

Table 7: Configuration for the Standard Intersection .ldp File 

Parameter Phase number 

Simul second   

Sig Display SG 1 2 4 5 6 8 

State Det 1 2 4 5 6 8 

Veh Ext Timer 1 2 4 5 6 8 

Min Green Timer 1 2 4 5 6 8 

Max Green Timer 1 2 4 5 6 8 

Active Phase 1 2  

Active Preemp   

Preempt Call 1 2  

Entrance Min Green   

Entrance Ped Clear   

Entrance Red   

Entrance Walk   

Entrance Yellow   

Track Clear Min Grn   
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Table 8: Configuration for the Railroad Crossing .ldp File 

Parameter Phase number 

Simul second   

Sig Display SG 202 204 208 

State Det 211 611 

 

Troubleshooting VISSIM input file creation 

There are two common problems that can occur when creating the necessary VISSIM files. Both 

of the problems can be detected either by observing the TrafficSense simulation or if the .ino file 

is opened with a text editing software similar to notepad. The first error occurs when vehicles in 

TrafficSense reach the end of the data before the rest of the simulation. This error is caused by an 

incorrect value on the “SIMULATION_DURATION” line of the .ino file. To correct this, the 

user should click the “Simulation” menu and then click “Parameters…” After the new window 

opens, the “Period:” time should be changed to match the period of time for which the rest of the 

data is collected. The second error occurs when vehicles are traveling extra fast. This is caused 

by an incorrect value on the “TIME_STEP” line of the .ino file. To correct this error, users 

should click the “Simulation” menu and then click “Parameters…” After the new window opens, 

the “Simulation resolution:” should be changed to match the resolution at which the rest of the 

data is collected.  

  



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 54 

APPENDIX 2 – ASSESSMENT OF TRAFFIC SENSE 

Introduction 

TrafficSense is a program written to help students learn about traffic signal timing. TrafficSense 

uses information gathered from a separate program called VISSIM and displays this information 

in a more user friendly environment while allowing students to see several of the signal timing 

processes and graphs. The program was originally written by students as junior and senior design 

projects. This report documents errors and recommends changes to be made. The 

recommendations are split into three sections, the first section suggests changes to the user’s 

manual. The second section includes traffic errors in TrafficSense. The third section includes 

aesthetic issues and recommendations on how to correct the issues. The conclusion of this report 

includes a list of the most important errors to be corrected.  

User’s manual 

The TrafficSense User’s Manual was designed as a document intended to be distributed with 

TrafficSense. Because of this, the user’s manual has been attached in a separate file titled 

“TrafficSense User’s Manual.” 

Traffic errors in TrafficSense and potential trends 

Three types of networks can currently be modeled by TrafficSense: standard timing, railroad 

preemption, and signal coordination. Standard timing networks model the VISSIM outputs of a 

single actuated intersection. Railroad preemption networks are similar to standard timing 

networks with the addition of a railroad periodically affecting the performance of the 

intersection. Signal coordination networks model a series of intersections along an arterial which 

are timed together. Future work will introduce volume density networks. The following sections 

will explain traffic related errors in TrafficSense and potential trends which could be added for 

standard timing, railroad preemption, and signal coordination models. 
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Standard Timing 

Vehicle	extension	timer	

Once a phase begins, the vehicle extension timer should start at its maximum value and begin 

timing down once there is not a vehicle being detected, at which point the timer should begin to 

count down. Until the timer reaches zero, every vehicle that enters the detection zone should 

reset the vehicle extension timer to the maximum value. At times, TrafficSense models this 

correctly; however typically the vehicle extension timer does not reflect the detector status. 

Figure 24 shows an example of how the vehicle extension timer currently is displayed. An edited 

version of Figure 24 showing the correct vehicle extension timing process is shown in Figure 25. 

 

Figure 24: Current vehicle extension timer process. 
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Figure 25: Corrected vehicle extension timer process 

 
Detector	location	

The location of the detectors is not properly displayed in TrafficSense. TrafficSense shows that 

vehicles are detected a while after they enter the detection zone and that the vehicles continue to 

be detected after leaving the detection zone. An example of a vehicle being detected when not in 

the detection zone shown by TrafficSense is shown in Figure 26. The actual locations of several 

of the detectors have been added to the TrafficSense model, shown in purple boxes. The orange 

boxes show the locations at which TrafficSense models the detectors. It should also be noted that 

although the vehicle is not in the detection zone shown by TrafficSense, the time trends on the 

left of Figure 26 show that the vehicle in the eastbound lane is currently being detected. 
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Figure 26: Actual detector locations and TrafficSense detector locations. 

	
Max	green	timer	

The max green timer should begin timing once a vehicle call has been placed in an opposing 

phase. Currently, the max green timer begins to time as soon as a phase turns green. An example 

of this is shown in Figure 27, where the eastbound phase has just turned green, no vehicles have 

been detected in any conflicting phases, but the max green timer is timing. 

 

Figure 27: Max green timer operating incorrectly. 
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Potential	trends	

There are three things that could be added to the standard timing models. First, a level of service 

(LOS) indicator could be added which would show the LOS for the intersection as a whole and 

for individual approaches depending on what was selected. For example, if the eastbound 

approach was selected, the LOS for that approach would be shown as well as the LOS for the 

intersection. The second trend which could be added is an indication of how the currently 

selected phase is going to terminate, either through gap out or max out. Finally, a trend could be 

added showing when a conflicting call has been placed. To help make room for these additional 

trends, the Purdue Coordination Diagram could be removed. 

Signal Coordination 

Purdue	Coordination	Diagram	

There are four issues related to the Purdue Coordination Diagram. First, when a link is initially 

selected, the Purdue Coordination Diagrams do not accurately plot to scale on the x-axis. This 

can be fixed manually by scrolling the mouse wheel while the cursor is over the x-axis, but 

should automatically be done. A second issue occurs when an individual vehicle is selected. The 

TrafficSense User’s Manual states that when an individual vehicle is selected, its corresponding 

point on the Purdue Coordination Diagram should be highlighted. However, this does not 

happen. Because the ability to correlate a vehicle in the Purdue Coordination Diagram and the 

time space diagram is beneficial to a user’s understanding of coordination, this should be added. 

Additionally, the y-axis of the Purdue Coordination Diagram should be scaled differently so that 

the entire diagram can be viewed whenever a link is selected, without significantly impacting the 

time space diagram. For the final cycle of each simulation, the coloring used is different than the 

colors used for the previous cycles. Finally, whatever phase was active at the end of the 

simulation is shown to extend indefinitely. 

Detector	

There are two issues with the detectors. First, when there are multiple lanes traveling in one 

direction, vehicles are only detected in the left lane. The second issue is that the detector 

locations in TrafficSense do not accurately model where the detectors were placed in VISSIM. 
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This causes TrafficSense to show vehicles being detected before they reach the detector and to 

stop being detected before leaving the detector. 

Max	green	timer	

Currently, TrafficSense does not show the timing process involved with the max green timer. 

This must be added for coordinated networks because the max green timer is what controls the 

duration of a phase for simple coordinated networks.  

Potential	trends	

For the signal coordination networks, a trend showing the level or service, average queue length, 

or other measure of effectiveness could be shown in the unused performance trends area of 

TrafficSense. This would be beneficial because making improvements to the major street of an 

arterial typically negatively impacts the minor streets. This trend would allow users to visualize 

this impact. 

Railroad preemption 

Vehicle	extension	timer	

At the start of each cycle, the vehicle extension timer decreases to zero, remains at zero for a 

short duration, and then begins to time correctly. The initial timing to zero and period for which 

the timer remains at zero should not exist. 

Detector	

The detectors have not been mapped to the location where vehicles are actually detected. To 

check the detector location for the railroad, the trains should check in as the front of a train 

activates the farthest upstream detector. Additionally, the detectors should curve with the road 

rather than extending off the road in a straight line. 

Max	green	timer	

Similar to the standard signal timing issue, the max green timer should only begin to time once a 

conflicting call has been placed. 
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General	issues	

There are several general issues that need to be corrected for the railroad preemption simulation. 

First, the time space diagram and time trends are currently not supported for the westbound 

traffic. For the 300 second railroad preemption model, the time trend and time space diagram 

will appear if the westbound lane in the middle of the intersection is clicked. This may simply be 

caused by how the network was constructed in VISSIM. 

Another issue is that the simulation opens in a poor location, forcing the user to adjust the map 

so that the intersection is viewable. When TrafficSense loads, the intersection should be centered 

in the “Traffic System” area. 

When a movement is selected, all signal heads related to it have a glow effect added to them. 

However, when the westbound phase of the railroad preemption network is selected, the 

northbound right turn signal head and an eastbound signal head located downstream of the 

intersection also have a glow effect added. An example of this is shown in Figure 28, with 

highlighted signal heads not relating to the selected movement boxed in red. This could 

potentially be caused by poor signal head number and mapping in VISSIM. 

 

Figure 28: Incorrect signal head highlighting. 

 
A final issue is that the railroad “check in” is not always displayed in the event timeline. An 

example of this is shown in Figure 29, where the train has just reached the upstream detector. At 

this time, the train should check in, activating the right of way transfer phase. However, the only 
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event included in the even timeline is the right of way transfer. The portion of the even timeline 

which should show “check in” has been boxed in red. 

Figure 29: Event timeline missing "check in." 

 
Potential	trends	

The unused space in the upper left of TrafficSense, currently titled “Performance Trends” could 

be used to plot the time until the track is clear versus the time until the train arrives. If this plot is 

created, the x-axis (time until the train arrives) would need to be plotted in reverse order. An 

example of what this graph could look like is shown in Figure 30. 

 

Figure 30: Potential railroad preemption trend. 

 

General errors 

Parsing	errors	

While TrafficSense is parsing the files, there are often files which TrafficSense cannot initially 

find and are therefore highlighted in red. However, after a short wait TrafficSense loads these 
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files and is able to create the simulation. If these files are not missing then TrafficSense should 

not highlight them as missing. If they are missing then there needs to be an error message saying 

so at the end of the parsing process. If possible, this message should include what affect the 

missing file will have on the simulation.  

Selection	order	issues	

The order in which links and vehicles are selected affects whether or not information will be 

displayed. There are two instances where this could be improved. The first is that if a user is 

interested in one specific vehicle they must first click the link it is on and then click the vehicle. 

If the vehicle is clicked first, TrafficSense responds as if only the link was selected. This should 

be changed so that clicking a vehicle selects the link as well. The second issue occurs when a 

user selects a link, then a vehicle, and the movement again. This causes TrafficSense to display 

no trends or diagrams although the link is still highlighted. This should be changed so that when 

the user selects the link the second time, the information related to the link remains, but the 

vehicle is no longer highlighted. 

Movements	which	cannot	be	selected	

Some of the movements cannot be selected in TrafficSense. These movements are typically 

turning movements. Support should be added for these movements as well so that users can 

compare the timing processes for various phases. Additionally, once these movements are fully 

supported, it would be good to be able to connect the time space diagram of a turning movement 

with the time space diagram of the through movement it turns onto. This can currently only be 

done for consecutive through movements. 

Map	movement	

To reposition the map, users must left click in the traffic system area and drag the map as 

desired. When the left mouse button is released, the map no longer moves with the mouse. 

However, if the mouse cursor is in the event timeline area of TrafficSense when the button is 

released, the map will move with the courser whenever the user next moves their cursor into the 

traffic system area. This should be updated so that releasing the left mouse button no longer 

moves the map regardless of mouse location. 



 

Using Visual Simulation Tools And Learning Outcomes-Based Curriculum . . . 63 

Aesthetic issues and improvements 

Starting a model 

Upon opening TrafficSense, there are two drop down menus which users can interact with: 

“File” and “View.” Because the user has nothing to view until a simulation has been created, 

“View” menu should be removed until after the data has been parsed and the simulation is 

working. If a user selects “File,” three options are available “New Simulation,” “Open…” and 

“Save As…” the save function does not serve any purpose until a simulation has been created. 

Therefore, “Save As…” should be grayed out, allowing users to know that later they can save 

their simulation from the “File” menu while preventing them from trying to select “Save As…” 

before it serves a purpose. 

Starting a new simulation model has several steps which seem to be unnecessary. To start a new 

simulation, the user must click “File,” “New Simulation,” select a specific model type, click 

“…Overview” and then click “Import Data…” After clicking “Import Data…,” a new window 

opens prompting the user to select the folder containing the needed files. This process would be 

shorter and less confusing if the final three steps were combined so that when a user selects the 

type of model they want to open, TrafficSense automatically takes the necessary action to allow 

the user to browse for the folder containing their desired files. 

Once a model type is selected, the user has to click on “…Overview.” If the simulation creation 

process is not simplified as described above, this step should be removed because “…Overview” 

is the only thing that a user can select at this point. 

Parsing progress bars 

Once a specific model has been selected and the data are loaded, TrafficSense will parse 

information, showing progress bars for each set of data. While the parsing information screen is 

useful during the creation of the TrafficSense software, a single loading bar would allow the user 

to see that TrafficSense is making progress while removing excess information. The advantage 

of allowing the user to see the parsing progress bars is that if an error occurs, the user can 

identify what caused the error to occur. However, if an error message told the viewer of any 

potential errors at the end of the parsing process, users would still be able to identify errors. This 

would make the parsing process much more user friendly.  
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Interaction with interface elements 

A major interface obstacle that needs to be addressed is the vertical blue timing bars found on the 

“Time Trends,” “Event Timeline,” “Purdue Coordination” and the “Time Space” diagrams. The 

blue timing bars are very difficult to click on and move around. The area behind the timing bars 

cannot be interacted with so the clickable area for each bar should be made wider. The Purdue 

Coordination Diagram and the time space diagram should share a similar time bar, meaning that 

if you change the location on the time space diagram the Purdue Coordination Diagram should 

move as well. The same meshing of time diagrams should also occur with the event timeline and 

the time trends diagrams. In addition, the event timeline and time trends diagrams should have 

their x-axes scale together if one is changed. 

“Traffic Trends” issues 

The traffic trends section of the interface has multiple y-axis labeling corrections. The detector 

graph should be labeled “on” instead of “true” and “off” instead of “false.” The vehicle 

extension, minimum green, and maximum green timers should display the maximum values in 

addition to the “0” time. For the signal display graph, the red, yellow, and green bars should line 

up correctly with their respective labels. 

General issues 

In the middle of the “Traffic System” screen a blue dot is present. This blue dot does not appear 

to have a purpose. Additionally, the blue dot is distracting and therefore should be removed. The 

blue dot can be seen highlighted in Figure 31 by a red rectangle. 
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Figure 31: Traffic system’s blue dot. 

 
When a movement is selected, the phase number of the roadway appears in the upper left hand 

corner in the “Traffic System” area of TrafficSense, as shown in Figure 32. If a phase is selected 

then deselected, the phase number still displays when it should not. 

 

Figure 32: Unselected phase issue. 
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In the “Event Timeline” it is difficult to distinguish between the light blue lines that correspond 

with each five second interval of time, the darker blue lines that correspond with signal display 

changes, and the dark blue line that corresponds to the current simulation time. It is 

recommended that the color of the lines corresponding to signal display changes be changed to 

help users differentiate between the lines. 

TrafficSense has an annotation mode with different drawing options that can only be accessed 

through hotkeys. To improve the user interface, a toolbar with a button for each of the hotkeys 

should be added. This toolbar could also have buttons which would allow the user to switch 

between presentation mode and annotation mode, eliminating the need for the “View” menu. 

If “File” is selected followed by “View” both of the drop down menus appear. In this case the 

file drop down menu should have disappeared. This could be fixed by having a left click outside 

of the menu close the menu, similar to how the start menu works in Windows. 

Improvements 

The most difficult file to configure correctly in VISSIM is the .LDP file because the 

configuration must be done in a precise order or TrafficSense does not parse the data correctly. 

Furthermore, the way that data is currently extracted from the .LDP file limits what type of 

networks can be modeled in TrafficSense. Usability of TrafficSense would greatly increase if 

users were able to configure VISSIM so that all available data was gathered into the .LDP files, 

even if the information was not necessary for TrafficSense. TrafficSense could then filter the 

information in the .LDP files and extract only what is necessary to create the simulation model.  

A second improvement that could be made would be the addition of a button which would resize 

and center the simulation model in the “Traffic System” area of TrafficSense without changing 

the current sizes of the trends or diagrams. This would work similarly to the “Show entire 

network” button in VISSIM. 

A final improvement could be made to roadway and background colors which are too similar. 

One way to correct this problem would be to lighten the background to an off white color. 

Additionally, making the roadway slightly darker would also help. 
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Conclusion 

The recommendations in this document along with the updated TrafficSense User’s Manual 

document both aesthetic improvements and traffic errors in TrafficSense. A prioritized list of the 

most important errors that must be fixed follows: 

 Detector locations 

 Vehicle extension timer not being correct 

 Purdue Coordination Diagram 

 Max green timer 

 Blue timing bars linked together and made bigger 

For the rest of the errors, in general, traffic errors should be prioritized over aesthetic issues.  
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APPENDIX 3 – OPERATIONS GUIDE 

Dynamic Data Environment 

This contains instructions for testing a “standard 5 process” traffic simulation in the “Dynamic 

Data Environment.” 

Each phase contains 5 standard processes: 

 Detector Display 

 Maximum Green Timer 

 Minimum Green Timer 

 Vehicle Extension Timer 

 Signal Display 

Testing Constraints:  

 During this test iteration, you will be limited to the simulation assets provided in the 

“TestDeliverables” folder. 

 Only the “Standard Timing Process” module is active. Railroad preemption, signal 

coordination and other modules are under development. 

Flow of events: 

1. Install and Start Application 

2. Template Browse Mode 

3. Template Configuration Mode 

4. Presentation Mode 

5.  Video Configuration Mode 

1. Install and Start Application 

 Open the installer package provided in the test folder (TestDeliverables 

9_20_2010/TrafficVisualization.air) 

 Once installed, run the application. 

2. Template Browse Mode: 
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 Browse and select different simulation modes available (only standard timing is active). 

 Select the “Standard Timing Processes” template button (stopwatch). 

 Select Create or Double click the button to proceed with that template. 

3. Template Configuration Mode: 

 Load assets required to run the simulation template 

 Load Data Asset – STEP 1 

o Select the Data File Icon to browse for a data file 

o Select the Text File found in the provided assets folder (TestDeliverables 

9_20_2010/assets/data.txt) 

 Load Data Map Asset – STEP 2 

o Select the Data Map File Icon to browse for a data map 

o Select the XML File found in the provided assets folder (TestDeliverables 

9_20_2010/assets/dataMap.xml) 

 Load Video Asset – STEP 3 

o Select the Video Icon to browse for a simulation video 

o Select the .fla file found in the provided assets folder (TestDeliverables 

9_20_2010/assets/traffic.fla) 

o See Known issue #2 “Video Playback Controller Load Error (00:00:00 / 0-1:0-1:00)” 

o If no load error occurred, select the finish button to start the simulation 

 You can also run this simulation with the other set of test assets provided  

o (TestDeliverables 9_20_2010/assets-2) 

o *See Known issue # 1 “Must Restart Application to Open A New Template” 

4. Presentation Mode: (order is not important here) 

 Enter Video Configuration Mode (again, order is not important, you can also make graphs 

first) 

o at any time during the presentation mode, you can enter/exit video configuration mode 

o select the “video” tab in the ribbon 

 Pan (move) video (must be in video configuration mode) 

o During video configuration mode, all other graphs are locked down so all you can modify 

is the video 
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o Select the “Pan Video” or hand icon in the ribbon. (the cursor will change into a hand) 

o Click and drag anywhere on the video to move it 

o unselect the Pan Video or select a new ribbon tab/tool to stop panning 

 Zoom Video (must be in video configuration mode) 

o To zoom in, click the + magnification glass icon 

o To zoom out, click the – magnification glass icon 

 Sync Video to Graph Data (must be in video configuration mode) 

o If the data on your graphs is not perfectly in sync with changes in the video 

o Select the “sync video” button 

o In the drop down menu, click and drag the blue input value to tune in the sync offset 

o This will offset your data from your video in .1 second increments 

o If you have any graphs created, you will notice their data moving independent of the 

video in response to the changing sync offset 

o Adjust the offset until  your data is in sync with changes in the video  

o (Easiest way to tell is to make a signal display graph, and make sure it changes signal 

color when the video does)  

o Unselect the sync video button to close the menu 

o Note that the sync value for the test data in the assets folder is -3.5 seconds 

o Note that the sync value for the test data in the assets -2 folder is 2.4  seconds 

o Drag the input area left until you reach that amount  

 Exit Video Configuration Mode 

o Select any other tab in the ribbon to return control to the graphs, and lock down the video 

 Creating Graphs: 

o In the presentation tab, select the “History Graph” button 

o In the dropdown list that appears, check any traffic processes you want to display 

o Hit the “Create” button to create them on the stage 

o To select an entire phase, check a header button 

o If you select multiple processes, they will be created in a group 

 Selecting Graphs: 

o Single Select: left click on an unselected graph 

o Add Select: Shift-click on an unselected graph to add it to the selection 
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o Subtract Select: Shift-Click on a selected graph to remove it from the selection 

o Select All: Ctrl + a 

o Unselect All: Ctrl + d or Left click the stage 

 Moving Graphs: 

o Select 1 or more graphs 

o Left click + drag on one of the selected graphs 

 Grouping Graphs: 

o Select 2 or more graphs 

o In the “data display tab” select the “Group” button 

o ***See Known Issue #3 “Grouping Groups Fails” 

o Graphs will be arranged from top to bottom in the order they were initially added to the 

selection. (shift-left clicked) – 

o ***See Known Issue #4 “Cant rearrange graphs in a group” 

 Ungrouping Graphs: 

o Select 1 or more graphs groups 

o In the “data display tab” select the “Ungroup” button 

o Any groups contained in the selection will be ungrouped 

 Deleting Graphs: 

o Select 1 or more graphs/groups 

o In the “data display tab” select the “Delete” button or press the “Delete” key 

 Zoom in/out & Pan graphs not active 

 Playback controls 

o Play: Begins/Continues playback (video and data animation)  

o Pause: Stops video and animation 

o Rewind: Returns video to the beginning and pauses 

Summary 

Once your standard timing process template is configured, you can:  

o Create as many process graphs as you wish 

o Zoom and move the video around as often as needed to key in on different concepts 

o Mix and match any graphs from any phase for useful comparison 
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o Scrub (move the timeline) through the data to find and discuss key points 

Known Issues: 

Issue #1: Must Restart Application to Open A New Template 

Frequency: Always. 
Cause: Functionality not implemented. 
Resolution Date: Next Development Cycle. 
Issue: 

 User cannot freely navigate between presentation mode and the template browser. 

 Once a template is chosen, configured, and made active, the user cannot open a different one.  

Desired Behavior: 

 Allow user to Navigate to and from the Template Browse Page 

 Allow user to select a new template 

 Allow user to cancel template browsing and return to current template 

Current Walk-around: 

To Open a different Template Type 

 Restart the application  

 Select the desired Template 

To Open the same template but with different assets 

 Restart the application  

 Select the same template 

 Load the new assets during the “Template Configuration” Phase 

Issue #2: Video Playback Controller Load Error (00:00:00 / 0-1:0-1:00) 

Frequency: Uncommon. 
Cause: Unknown 
Resolution Date: ASAP 
Issue: 
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 During Template Configuration, Loading a Video asset occasionally results in a “time error” 

onthe Video’s Playback Controller. The Time value for the controller will show:  

 “00:00:00 / 0-1:0-1:00” 

 Finishing the configuration and then trying to hit the Play button will result in a flash error. 

Current Walk-around: 

 When you load your video asset, check the playback control’s Time display 

 If the erroneous time “00:00:00 / 0-1:0-1:00” is showing, select the “Back” button 

 You are now back in template browse mode 

 Reselect the template, and reload your assets 

 Repeat if necessary 

 If there is no apparent time error, select the finish button to begin the simulation 

Issue #3: Grouping Groups Fails 

Frequency: Always. 
Cause: Grouping a selection that contains 2 or more groups 
Resolution Date: Next Development Cycle. 
Issue: 

 If a user selects 2 or more items from the stage, where 2 or more of those items currently 

exist in separate groups, trying to group those items will fail. 

 All Ungrouped Items will add to the first group selected. 

 All Grouped items will remain separate. 

Desired Behavior: 

 Any item, no matter its group status can successfully group to another. 

Current Walk-around: 

To group 2 or more groups together 

 Select all the items/item groups you wish to group 

 Ungroup the selection. (this will break up any preexisting groups) 
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 The order of the group is indeterminate at this point, because ungrouping changes the 

selection order 

 Unselect the items, and Reselect them in the order you wish them to be arranged, top to 

bottom 

 Group the selection  

Issue #4: Can’t Rearrange Graphs in a group 

Frequency: Always. 
Cause: Functionality not implemented. 
Resolution Date: Uncertain. 
Issue: 

 If a user creates a group of graphs, those graphs are locked in their arrangement. 

 A user cannot move one graph up or down within the graph group to more easily compare it.  

Desired Behavior: 

 A user can move graphs up and down within a graph group to achieve optimal comparisons 

with other graphs in the group. 

Current Walk-around: 

 Reorder the graph group 

 Select the graph group 

 Ungroup the graph group 

 Unselect the ungrouped graphs (click on the stage somewhere, or ctrl + d) 

 Shift-Select the graphs in the order you want them arranged (top to bottom) 

 Regroup the selection 

Other Known issues: 

Line Graph Plotter Glitch: 

 Plotter is drawing a line at the base of the graph for 0 values. 

Template Description Glitch: 
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 Html description styling is lost from the description text if the template button is unfocused 

and then refocused. Well styled text turns into a large bulleted list. 

Need to integrate Header Rows, Sample Rate, and Index Column into the data map rather than as 

options on the data tab: 

 These settings cannot change once the simulation starts, and they must be accurate for the 

simulation to function. They should be set during the configuration stage. 

Information updated September 20, 2010 by Bryan Foutch & Devin Abolins. 


